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 SAM-BA® Monitor for ROMless Cortex™-M devices

Introduction

The SAM Boot Assistant (SAM-BA®) allows In-system Programming (ISP) using a USB or UART host
without any external programming interface. In general, SAM-BA Monitor is factory programmed to ROM,
if it exists. If ROM does not exist, by default, SAM-BA is not supported. To support SAM-BA in ROMless
devices, the SAM-BA Monitor application can be loaded in the Flash memory.

This application note focuses on ROMless Cortex™-M devices and explains the SAM-BA Monitor and its
interfaces on these devices. The SAM-BA Monitor is compatible with existing SAM-BA software tools, but
has some differences compared to other Cortex-M devices. These differences are explained in this
document.

Features

• Allows the end user to program, verify, and secure a device without a programmer
• Allows the end user to upgrade an application’s firmware
• Provides a configurable Start condition using an I/O pin
• Supports USB-CDC and UART interfaces
• Source code is available, which can be customized to user requirements
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1. SAM-BA Introduction
The SAM Boot Assistance (SAM-BA) software provides an open set of tools for programming Microchip
SAM ARM® Thumb®-based microcontrollers. They are based on a common dynamic linked library (DLL),
the AT91Boot_DLL, which is used by the SAM-BA and all ISP tools.

SAM-BA is used to establish a communication between a Host Graphical User Interface (SAM-BA GUI)
running on a PC and a target device (Cortex-M device) from an existing system board.

The communication protocols used are as follows:
• USB
• UART
• JTAG

Figure 1-1. SAM-BA Connections Overview

1.1 Applet Introduction
To acknowledge the host requests, the target must be able to perform several functions when the host
asks for a read/write/erase on a specific memory. Therefore, those functions, called applets, must be
previously loaded into the RAM. An applet is a small program running on the target, which is used by
SAM-BA to enable programming of non-volatile memories, low-level initialization, or other peripherals. For
each SAM device, there is one dedicated applet to each memory device the chip interacts with.

1.2 SAM-BA Monitor
To communicate with the SAMB-BA GUI, a command interpreter, named as SAM-BA Monitor, must be
placed in the target. Some SAM devices have the SAM-BA Monitor factory ROMed (see Figure 1-2), and
some others do not have the SAM-BA Monitor; therefore, it must be loaded in the embedded Flash
memory (see Figure 1-3). Those types of devices are called ROMless devices.
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Figure 1-2. SAM ROM-based System Board

Figure 1-3. SAM ROMless-based System Board

The SAM-BA Monitor provides an easy way to program in-situ the on-chip Flash memory. The SAM-BA
Monitor supports both USB-CDC and UART communications. The SAM-BA Monitor will continuously look
for a Start condition on the UART and/or USB interfaces. When the Start condition is detected, SAM-BA
Monitor enters into an infinite loop waiting for SAM-BA GUI commands.

The Start condition on the USB interface is enumeration completion. When the SAM-BA Monitor detects
enumeration with the Host is completed, it will start waiting for SAM-BA commands.

The Start condition on the UART interface is ‘#’. When the SAM-BA Monitor receives this character, it will
start waiting for SAM-BA commands.
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2. ROMless Cortex-M Devices
The following table provides a list of current Cortex-M devices that do not have a ROMed or factory
programmed (in Flash) SAM-BA Monitor. Microchip has provided a SAM-BA Monitor example for the
dedicated XPlained Pro boards, but the SAM-BA Monitor remains an open source tool that can also be
easily ported to any device of a ROMless product family.

Table 2-1. ROMless Cortex-M Devices

Product Family Xplained Pro Board (On-board Device) Core

SAM L22 SAML22 Xplained Pro (SAML22N18A) Cortex-M0+

SAM L21 SAML21 Xplained Pro (SAML21J18B) Cortex-M0+

SAM D21 SAMD21 Xplained Pro (SAMD21J18A) Cortex-M0+

SAM C21 SAMC21 Xplained Pro (SAMC21J18A) Cortex-M0+

SAM D5x/E5x SAME54 Xplained Pro (SAME54P20A) Cortex-M4
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3. Hardware Requirements
The SAM-BA Monitor uses a general purpose I/O (Bootloader Entry Pin) to determine if the SAM-BA
Monitor will start or execute application Flash.

The following table provides signals and their description in corresponding interfaces.

Table 3-1. SAM-BA Monitor UART Mode Connections

Signal Name Description

UART RXD Serial communication (115200-8-N-1) receive line

UART TXD Serial communication (115200-8-N-1) transmit line

Bootloader Entry Pin GPIO pin to determine execution (i.e., either to
execute application or listen for SAM-BA host
commands)

Table 3-2. SAM-BA Monitor USB Mode Connections

Signal Name Description

USB D+ USB connection to Host

USB D- USB connection to Host

Bootloader Entry Pin GPIO pin to determine execution (i.e., either to
execute application or listen for SAM-BA Host
commands)

Note:  For any device-specific requirements to enable Serial or USB communication, refer to the
corresponding device’s data sheet and/or schematic checklist section.
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4. Software Implementation
This application note is provided with an example SAM-BA Monitor application that is based on Atmel®
Studio. The full source code is available and it can be easily ported to IAR/KEIL, depending on user
requirements.

4.1 Memory Map
A reserved space of Flash memory for the SAM-BA Monitor application is required. The size of this space
is from 0x00000000, to the Application Start Address (0x00002000), to ensure consistency among
various combinations of compilers (i.e., GCC/IAR and UART, and/or USB-CDC interface).
Figure 4-1. Device Memory Map

4.2 Design Considerations
The following are the design considerations for this implementation:

• UART and USB drivers support most peripheral variants used in ROMless Cortex-M devices
• In this application note, Atmel Studio 7 must be used to program the SAM-BA Monitor into the

device
• Tool versions used for development and testing are the latest release of Atmel Studio 7 and SAM-

BA GUI 2.xx
• Compilation is performed using the ARM/GNU Compiler 6.2.1, with Optimization -Og,

STACK_SIZE=0x280, --specs=nano.specs

4.3 Configurations
The SAM-BA Monitor application allows configurations to customize it for user needs. Following are the
configurations for customization:

• Communication interface UART or USB, or both:
– In case of UART, SERCOM instance on the device

• Bootloader Entry Pin that controls SAM-BA Monitor execution
• Application start address, changing application start address requires

– Regenerating applets for the SAM-BA host
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– Relocating application to the new start address

The following table provides configurations in the example application.
Table 4-1. SAM-BA Configurations in Example Application

Device Configuration Current Setting

SAM L22 (SAML22N18A) Communication interface Both USB and UART

SERCOM instance SERCOM4 (PC24D, PC25D)

Bootloader Entry Pin PC01

SAM L21 (SAML21J18B) Communication interface Both USB and UART

SERCOM instance SERCOM3 (PA22C and PA23C)

Bootloader Entry Pin PA02

SAM D21 (SAMD21J18A) Communication interface Both USB and UART

SERCOM instance SERCOM3 (PA22C and PA23C)

Bootloader Entry Pin PA15

SAM C21 (SAMC21J18A) Communication interface Both USB and UART

SERCOM instance SERCOM4 (PB10D, PB11D)

Bootloader Entry Pin PA28

SAM E54 (SAME54P20A) Communication interface Both USB and UART

SERCOM instance SERCOM2 (PB25D, PB24D)

Bootloader Entry Pin PB31

4.4 Memory Usage
The SAM-BA Monitor application is targeted to use limited Flash and SRAM, therefore, it can be ported to
low footprint devices like 32K Flash and 4K SRAM. The following table illustrates Flash and SRAM
consumption for different devices.

Note:  Latest version of Atmel Studio, ARM/GNU Compiler 6.2.1, Optimization -Og,
STACK_SIZE=0x280, --specs=nano.specs.

Table 4-2. SAM-BA Monitor Memory Usage

Device USB + UART (Flash/
SRAM) in Bytes

USB Only (Flash/
SRAM) in Bytes

UART Only (Flash/
SRAM) in Bytes

SAML22N18A 4488/ 1168 3384/1160 2400 / 688

SAML21J18B 4508 / 1168 3404 / 1160 2420 / 688

SAMD21J18A 4524 / 1168 3436 / 1160 2464 / 688

SAME54P20A 4768 / 1168 3716 / 1160 2952 / 688

Note:  This memory usage information may change if the development environment changes (i.e.,
Toolchain change, option changes, etc.).
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5. Rebuilding SAM-BA Monitor
The source code for the SAM-BA Monitor is provided with this application note, which contains an Atmel
Studio project configured for GCC. To use the SAM-BA Monitor for other devices or configurations, the
SAM-BA Monitor project must be rebuilt with the required changes.

Use the following steps to rebuild for the SAM L22. Similar steps can be followed for any other ROMless
Cortex-M devices.

5.1 Example of Porting the SAM-BA Monitor to a SAM L22 Using Atmel Studio
1. Open samba_monitor.atsln from the zip archive provided with this application note.
2. Create a device-specific configuration file similar to the existing device configuration files in the

device_config folder. In this case it is device_config_saml22n18a.h. Include this new configuration
file in device_config\device_config.h when the device is defined.
2.1. The following configurations are used for SAML22:

2.1.1. Communication interface - Both USB and UART, choose SAM_BA_INTERFACE
as SAM_BA_BOTH_INTERFACES

2.1.2. Default APP_START_ADDRESS (i.e., 0x00002000)
2.1.3. Add SAML22N18A support in device_config.h as shown in the following code

example:
#elif defined (__SAML22N18A__)
#include "device_config_saml22n18a.h"
#define SAM_BA_INTERFACE   SAM_BA_BOTH_INTERFACES
#define APP_START_ADDRESS  DEFAULT_APP_START_ADDRESS

2.2. Revisit all other macros and in-line functions in device_config_saml22n18a.h and ensure
they match the current device settings. Refer to the specific device data sheet for
configuration details.

Note:  Updated device_config.h and device_config_saml22n18a.h files are provided with this
application.

3. Open properties by selecting Project > Properties, and then navigate to:
3.1. Device > Change Device

3.1.1. Select New Device. The Device_Startup folder should be updated for the new
device.
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4. Rebuild the project. The new hex and bin files are ready to use in the output folder.

5.2 Relocating Application to the New Start Address
1. Open the application project and relocate it to the new address configured in samba_monitor. In

this case it is 0x00002000.
1.1. Open Properties, by selecting Project > Properties and then navigate to Tool chain >

ARM/GNU Linker > Miscellaneous.
1.1.1. Add -Wl,--section-start=.text=0x2000,.

2. For an application that is using the same USART or USB interface, it may need to reinitialize as per
application needs. Otherwise, the application may continue using configurations from the SAM-BA
Monitor.

3. Rebuild the project. The application hex and bin files should be ready to use in the Debug/Release
folder.
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5.3 Regenerating Applets for the SAM-BA Host
Use the following steps to change the start address of the application. Refer to http://
www.microchip.com//wwwAppNotes/AppNotes.aspx?appnote=en591431, for a complete details on how
to customize and regenerate applets for the SAM-BA Host.

1. Go to the SAM-BA installation directory, by default it is located in Program files (x86)/Atmel/sam-ba.
2. Locate the applets\samda1\sam-ba_applets\flash\ flash_app_main.c file.

2.1. Edit the MONITOR_SIZE macro in the C file to match the Application Start address in the
customized SAM-BA Monitor and save the file.

2.2. Open a CMD window with administrator privileges.
2.2.1. In search programs and files, type cmd.
2.2.2. Use Ctrl+Shift+Enter to open instead of Enter (with administrator privileges).

2.3. Navigate to the applets\samda1\sam-ba_applets\flash folder by using the cd command.
2.4. In this folder, enter the make –v command to display the make version. If not, refer to the

GNU Make 3.81 section in the application note, available for download at: http://
www.microchip.com//wwwAppNotes/AppNotes.aspx?appnote=en591431.

2.5. Open the cmd window and Run make.
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2.6. The updated bin file should be generated in the bin folder.
2.6.1. Go to the tcl-lib\saml22_xplained_pro folder and copy the bin file.
2.6.2. Restart the SAM-BA host utility to use the updated bin file.

Once all of the steps above are completed successfully, the SAM-BA Monitor and SAM-BA host should
be ready for the SAM L22 device.

Note:  Updated applets source code, bin, and tcl files are provided for all the ROMless Cortex-M devices
folder.
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6. Using SAM-BA Monitor

6.1 Programming SAM-BA Monitor
Programming the SAM-BA Monitor can be done using a Serial Wire Debug (SWD) probe:

1. In Atmel Studio, select Tools > Device Programming.
2. Select the Tool, and then click Apply.
3. From the Memories tab, erase the chip by clicking Erase now.
4. Specify the path to the SAM-BA Monitor image in the Flash field and click Program.

Figure 6-1. Device Programming

5. Alternatively, the command-line programming tool, atprogram, can also be used for programming
the hex file. The following example can be used to program the SAML22N18A device which is
available on the SAM L22 Xplained board.

atprogram –t edbg –i swd –d atsaml22n18a program –f
samd21_sam_ba_both_interfaces.hex

6.2 Entering the SAM-BA Monitor
SAM-BA Bootloader activation can be requested using any one of the following conditions:
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External Condition: Pull the Bootloader Entry Pin low while releasing the device from the Reset
condition. A common usage is to use a push button accessible by the user as a SAM-BA Monitor trigger.
The user must press and hold the push button when powering up or resetting the device.

Internal Condition: On erased devices or when the application reset vector (@APP_START_ADDRESS
+ 4) is blank (0xFFFFFFFF).

Figure 6-2. SAM-BA Monitor Boot Process
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7. Running SAM-BA on Windows®
This section presents the basic steps to run the SAM-BA GUI on a Windows® PC. For complete details,
refer to the SAM-BA User guide (<samba-install-directory>\doc\sam-ba user guide.pdf).

7.1 Connecting to SAM-BA GUI
To use the SAM-BA Monitor with the UART interface, connect the hardware to the PC through the
detected COM port or the selected serial port.
Note:  For the SAM L22 Xplained Pro, the UART interface is output using the DEBUG USB port.

To use the SAM-BA monitor with the USB interface, connect the hardware to the PC through the TARGET
USB port.

Click Connect to establish connection with the device.

7.2 Flash Programming
On successful connection to the device, the following SAM-BA screen will be displayed, which allows
various interactions with the device. For upgrading an application, the user need to erase existing
application and then download or upload the file. The contents of the Flash are loaded using the Flash
tab. While uploading a program to Flash memory, the start address must match the configured value in
the SAM-BA Monitor and applet (in the example SAM-BA Monitor it is 0x2000); otherwise, the transfer
process will be aborted.

Flash Programming
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1. Erase the application by choosing the Erase application area script and then click Execute.

2. Select the file to download to device Flash and then change the Address to 0x02000.

3. Click Send File.

7.3 Scripts
The following predefined scripts are available with SAM-BA Host.
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Table 7-1. Predefined Scripts

Script Name Description

Set Security Bit Set the security bit to secure the device. Refer to
"NVMCTRL" chapter in the specific device data
sheet for more information.

Read Security Bit Read the current security state

Erase application area Erase all application code (SAM-BA Monitor region
will not be erased).

Invalidate application Erase first page of application.

Read Fuses Returns the values of fuse settings. Refer to the
"NVM User Row Mapping" section in the specific
device data sheet for more information.

Read Lock Fuses Read the current lock settings

Read Device ID Read the Device Identification register

Set Lock Bit [0:15] Set the specified lock bit to prevent any erasure of
Flash memory region. Refer to the "NVMCTRL"
chapter in the specific device data sheet for more
information.

Unlock all Unlock all Flash memory regions.
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8. Other Solutions
The SAM-BA Monitor is also provided in various other options. The following table presents various
options and use cases.

Table 8-1. 

SAM-BA Monitor Option Description

ASF-based SAM-BA Monitor SAM-BA Monitor is developed using the Atmel
Software Framework (ASF). It is easy to port to
various devices as it takes care of drivers porting
for various SERCOM or USB instances or variants
on the device.

Due to the ASF, it is a little higher in footprint. (24
KB in ASF 3.32).

ROM-based SAM-BA Monitor On some devices, such as the Cortex-M3 / M4 /
M7 series SAM devices, where ROM is available,
the SAM-BA Monitor is loaded into ROM. It will be
activated based on the GPNVM bit setting on the
reset. Refer to the specific device data sheet for
details.

Legacy IAR Projects The following Legacy Projects are also included in
this application note zip folder:

• Atmel-42238-UART-based-SAM-BA-
Bootloader-for-SAM-D20_AP-
Note_AT04189.zip

• Atmel-42366-SAM-BA-Bootloader-for-SAM-
D21_ApplicationNote_AT07175.zip
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9. References
• Atmel-42438-SAM-BA-Overview-and-Customization-Process_ApplicationNote_AT09423.pdf
• Atmel-42728-Using-SAM-BA-for-Linux-on-SMART-ARM-based-

Microcontrollers_ApplicationNotes_AT15004.pdf
• SAM-BA User Guide: <samba_install_dir>\doc\sam-ba user guide.pdf
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10. Revision History
Table 10-1. Rev. A - 11/2017

Description

This is the initial release of this document.
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The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as
a means to make files and information easily available to customers. Accessible by using your favorite
Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQ), technical support requests,
online discussion groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products.
Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata
related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://www.microchip.com/. Under “Support”, click on
“Customer Change Notification” and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support.
Local sales offices are also available to help customers. A listing of sales offices and locations is included
in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is one of the most secure families of its kind on the

market today, when used in the intended manner and under normal conditions.
• There are dishonest and possibly illegal methods used to breach the code protection feature. All of

these methods, to our knowledge, require using the Microchip products in a manner outside the
operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is
engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.
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• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their
code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the
code protection features of our products. Attempts to break Microchip’s code protection feature may be a
violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software
or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice
Information contained in this publication regarding device applications and the like is provided only for
your convenience and may be superseded by updates. It is your responsibility to ensure that your
application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS
CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE.
Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life
support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend,
indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings,
BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeeLoq logo,
Kleer, LANCheck, LINK MD, maXStylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB,
OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA,
SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of
Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight
Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip
Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, BodyCom,
chipKIT, chipKIT logo, CodeGuard, CryptoAuthentication, CryptoCompanion, CryptoController,
dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial
Programming, ICSP, Inter-Chip Connectivity, JitterBlocker, KleerNet, KleerNet logo, Mindi, MiWi,
motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PureSilicon, QMatrix, RightTouch logo, REAL
ICE, Ripple Blocker, SAM-ICE, Serial Quad I/O, SMART-I.S., SQI, SuperSwitcher, SuperSwitcher II, Total
Endurance, TSHARC, USBCheck, VariSense, ViewSpan, WiperLock, Wireless DNA, and ZENA are
trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of
Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2017, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.
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ISBN: 978-1-5224-2348-5

Quality Management System Certified by DNV

ISO/TS 16949
Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer
fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California
and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC®

DSCs, KEELOQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and
analog products. In addition, Microchip’s quality system for the design and manufacture of development
systems is ISO 9001:2000 certified.
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